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Copyright and Trademarks

Copyright © 1995, 2012, Oracle and/or its affiliates. All rights reserved.

This software and related documentation are provided under a license agreement containing
restrictions on use and disclosure and are protected by intellectual property laws. Except as
expressly permitted in your license agreement or allowed by law, you may not use, copy,
reproduce, translate, broadcast, modify, license, transmit, distribute, exhibit, perform, publish or
display any part, in any form, or by any means. Reverse engineering, disassembly, or decompilation
of this software, unless required by law for interoperability, is prohibited.

The information contained herein is subject to change without notice and is not warranted to be
error-free. If you find any errors, please report them to us in writing.

If this software or related documentation is delivered to the U.S. Government or anyone licensing it
on behalf of the U.S. Government, the following notice is applicable:

U.S. GOVERNMENT RIGHTS

Programs, software, databases, and related documentation and technical data delivered to U.S.
Government customers are "commercial computer software" or "commercial technical data”
pursuant to the applicable Federal Acquisition Regulation and agency-specific supplemental
regulations. As such, the use, duplication, disclosure, modification, and adaptation shall be subject
to the restrictions and license terms set forth in the applicable Government contract, and, to the
extent applicable by the terms of the Government contract, the additional rights set forth in FAR
52.227-19, Commercial Computer Software License (December 2007). Oracle USA, Inc., 500
Oracle Parkway, Redwood City, CA 94065.

This software is developed for general use in a variety of information management applications. It is
not developed or intended for use in any inherently dangerous applications, including applications
which may create a risk of personal injury. If you use this software in dangerous applications, then
you shall be responsible to take all appropriate fail-safe, backup, redundancy and other measures
to ensure the safe use of this software. Oracle Corporation and its affiliates disclaim any liability for
any damages caused by use of this software in dangerous applications.

Oracle and Java are registered trademarks of Oracle Corporation and/or its affiliates. Other names
may be trademarks of their respective owners.

This software and documentation may provide access to or information on content, products and
services from third parties. Oracle Corporation and its affiliates are not responsible for and
expressly disclaim all warranties of any kind with respect to third party content, products and
services. Oracle Corporation and its affiliates will not be responsible for any loss, costs, or damages
incurred due to your access to or use of third party content, products or services. The RMW product
includes software developed by the Visigoth Software Society.
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Preface

Oracle's Agile PLM documentation set includes Adobe® Acrobat PDF files. The Oracle Technology
Network (OTN) Web site http://www.oracle.com/technetwork/documentation/agile-085940.html
contains the latest versions of the Agile PLM PDF files. You can view or download these manuals
from the Web site, or you can ask your Agile administrator if there is an Agile PLM Documentation
folder available on your network from which you can access the Agile PLM documentation (PDF)
files.

Note  To read the PDF files, you must use the free Adobe Acrobat Reader version 9.0 or later.
This program can be downloaded from the Adobe Web site http://www.adobe.com.

The Oracle Technology Network (OTN) Web site
http://www.oracle.com/technetwork/documentation/agile-085940.html can be accessed through Help
> Manuals in both Agile Web Client and Agile Java Client. If you need additional assistance or
information, please contact My Oracle Support (https://support.oracle.com) for assistance.

Note  Before calling Oracle Support about a problem with an Agile PLM manual, please have
the full part number, which is located on the title page.

TTY Access to Oracle Support Services

Oracle provides dedicated Text Telephone (TTY) access to Oracle Support Services within the
United States of America 24 hours a day, 7 days a week. For TTY support, call 800.446.2398.
Outside the United States, call +1.407.458.2479.

Readme
Any last-minute information about Agile PLM can be found in the Readme file on the Oracle

Technology Network (OTN) Web site http://www.oracle.com/technetwork/documentation/agile-
085940.html.

Agile Training Aids

Go to the Oracle University Web page
http://www.oracle.com/education/chooser/selectcountry _new.html for more information on Agile
Training offerings.

Accessibility of Code Examples in Documentation

Screen readers may not always correctly read the code examples in this document. The
conventions for writing code require that closing braces should appear on an otherwise empty line;
however, some screen readers may not always read a line of text that consists solely of a bracket or
brace.

This documentation may contain links to Web sites of other companies or organizations that Oracle
does not own or control. Oracle neither evaluates nor makes any representations regarding the
accessibility of these Web sites.
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Chapter 1
Patch Installation

This chapter includes the following:

S (1 (=10 17T 1
B PreinStallation STEPS ..o 2
= Backing out from the Patch INStallation ..o e 2
R (115121110 IS T o TSP 3
= RPD and Web Catalog ChanGES .......ccccucueiiiueiicisi ettt st as st sttt s 5

This document describes the steps to install Agile PLM Business Intelligence Service Pack 3.2.0.2.0
on an existing instance of Agile PLM Business Intelligence of 3.2.0.1.0 or any 3.2.0.1.x release.

This Service Pack release contains the following:

o Cumulative fixes from Agile PLM Business Intelligence Patch 3.2.0.1.1 to the Agile PLM
Business Intelligence 3.2.0.1.9 release.

o Certification for Agile PLM 9.3.0.3

o Certification for Agile PLM 9.3.1

o Certification for Agile PLM 9.3.1.1

o Certification for Agile PLM 9.3.1.2

o Certification on Real Application Cluster (RAC)
o Certification on Oracle 11gR2

Important Do not apply this service pack if you are using PLM Business Intelligence version
3.2.0.1.9.

Prerequisites

Agile PLM Business Intelligence 3.2.0.1.0 or 3.2.0.1.x must already be installed.
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Preinstallation Steps

Perform the following steps before installing this patch release:

1. Stop the following:

ODI Agents
Scheduler Agent
ETL tasks

2. Export or copy the following and store them in a backup location in order to enable a back-out
at a later stage:

a.
b.
c.

Export the MDS Schema
Copy the existing RPD file
Copy the Web Catalog folder

Backing out from the Patch Installation

If, for any reason, a back-out is required from the patch installation, and you have implemented the
above steps, you can back out from the patch installation by completing the following steps:

1.

Restore the MDS Schema by importing the previously backed up database export dump to
a schema with the same username and password.

Remove temp tables (i$, j$ and C$) from all the schemas.

Change the ETL configuration to run Data Mart and MDS in FULL load mode.

Restore the RPD file from the backup location.

Restore the Web Catalog from the backup location.

Agile Product Lifecycle Management



Chapter 1: Patch Installation

Installation Steps

To complete the patch installation, perform the following steps:

1. Set the environment variable to point to the PLM Bl home directory (where the existing Agile
PLM BI 3.2.0.1 software is installed).

In Windows: Set PLMBIMDS_Home = D:/PLMBIMDS
In Linux and Solaris: export PLMBIMDS_Home = /home/oracle/PLMBIMDS

2. Copy the BI3202.zip file to the PLM Bl home directory.

3. Unzip the content from the BI13202.zip file.

Enter the following command to extract the contents of the .zip file.
jar -xvf BI3202.zip

After you extract the files, the PLM Bl home directory (%PLMBIMDS_Home% or $PLMBIMDS_Home)
displays the following folders under the Patches folder:

*  BI3202
= et
= schema
= RPD

=  webcatalog

4. Execute the SQL script to apply MDS schema changes.

1. Using the command prompt, or shell prompt terminal, log into the MDS schema.

2. After connecting to the MDS Schema, execute the following script:

SQL>@MDS3202.sqgl

v.3.2.0.2 3
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The MDS3202.sql script can be found at the following location:

In Windows: %PLMBIMDS_Home%\Patches\BI3202\schema
In Linux and Solaris: $PLMBIMDS_Home/Patches/BI3202/schema

5. Execute the batch file to import the MDS ODI ETL components. The batch file can be found at
the following location:

In Windows: $PLMBIMDS_Home%\bin
In Linux or Solaris: $PLMBIMDS_Home/bin

1. Execute the batch file as follows:

In Windows:
cd $PLMBIMDS Home%\bin
BIInstall sp.bat <BI HOME>

Note  Replace <BI_HOME> with the PLM BI home directory path. For example: Replace
<BI_HOME> with D:\PLMBIMDS

In Linux or Solaris:
cd $PLMBIMDS Home\bin
./BIInstall sp.sh <BI_ HOME>

Note  Replace <BI_HOME> with the PLM Bl home directory path. For example: Replace
<Bl_HOME> with /home/oracle/PLMBIMDS

Important Make sure that the BIInstall sp.sh has ‘Execute’ privileges.
Make sure that $ODI_HOME/bin folder is present in Operating System Path.

6. After applying the patch, execute a FULL ETL load.
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RPD and Web Catalog Changes

You can find the RPD file at the following location:

In Windows: %PLMBIMDS_Home%\Patches\BI3202\rpd\PLMA.rpd
In Linux and Solaris: $PLMBIMDS_Home/Patches/BI3202/rpd/PLMA.rpd

You can find the Web Catalog PLMA folder at the following location:

In Windows: %PLMBIMDS_Home%\Patches\BI3202\webcatalog\PLMA
In Linux and Solaris: $PLMBIMDS_Home/Patches/BI3202/webcatalog/PLMA

Important Before upgrading the RPD file, you must look for differences between your existing

RPD file (that is currently in your local environment) and the new RPD file (that is
provided with this patch).

Identifying Differences between RPD Files

To identify the differences between your existing RPD file and the new RPD file provided in
this patch, follow these steps:

1.

In the Oracle BI Administration Tool, select File > Open > Offline.

In the Open dialog box, navigate to the location for the new RPD file, select the new RPD file,
and click Open.

Enter your username and password in the Open Offline PLMA.rpd dialog box, and click OK.

Go to File > Compare.

From the Select Original Repository dialog box, find and select your existing RPD file.
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Note  Unless you have changed the name of your existing RPD file, the new RPD file and
your existing RPD file have the same name - PLMA.rpd.

6. Enter username and password in the Open Offline PLMA.rpd dialog box, and click OK.

7. You now get an Oracle Bl Administration Tool dialog box, with the question: Do you want to mark
differences in the repository immediately? Click No.

The Compare repositories window displays the changes between the existing RPD file and the
new RPD file.

8. You can save all the differences between the two repositories in a spreadsheet. From the
Compare repositories window, select Save.

Upgrading the RPD File

Note  Ensure that you stop the BIServer Service before replacing the RPD file. To ensure all
customizations are properly merged (if you have customized the existing PLMA.rpd file),
refer to OBIEE documentation on how to perform an RPD merge.

Important Ensure to perform the RPD merge before upgrading the RPD file.

To upgrade the RPD File:
1. Create a backup copy of the existing PLMA.rpd file.

Important Do not delete your existing RPD file!

2. Your existing RPD file is located at <ORACLE_BI_HOME>/server/repository!/.

6 Agile Product Lifecycle Management



Chapter 1: Patch Installation

3. Copy your existing RPD from the above location, and place the copy of your existing RPD file
in a completely different location!

4. Copy the new RPD file (from the location given at the beginning of this section), and paste it at
the following location:

File Path: <ORACLE_BI_HOME>/server/Repository

5. Restart the BlServer Service after you have successfully completed the above steps.

Note  Configure the MDS Schema Connection Pool details using the OBIEE Admin Tool. For
more information on how to do this, see the PLM Business Intelligence Setup Guide.

Upgrading the Web Catalog

To upgrade the Web Catalog:

1. Copy the PLMA webcatalog folder from the location where the patch was extracted
(Patches>BI3202>webcatalaog).

2. Paste the PLMA webcatalog folder in the following location:

File Path: <ORACLE_BI_HOME>/OracleBlData/web/catalog
File Name: PLMA

PLMA/root/shared/product+changes/change+analyst/submitted+issues
open+change+orders+-+detailed

open+change+orders+-+detailed.atr
open+change+orders+not+implemented+-+detailed
open+change+orders+not+implemented+-+detailed.atr
open+change+requests+-+detailed

open+change+requests+t-t+detailed.atr
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PLMA/root/shared/product+changes/change+orders/overview
ftr+by+sign-off+user+group
ftr+bytsign-off+user+group+-+detailed
ftr+by+sign-off+user+group+-+detailed.atr

ftr+byt+sign-off+user+group.atr

PLMA/root/shared/product+changes/co%6efiguration+manager/summary
sign-off+cycle+timetby+sign+off+user+group
sign-off+cycle+time+by+signt+off+user+group.atr
PLMA/root/shared/product+changes/mfr+change+orders/overview
ftr+by+sign-off+user+group

ftr+by+sign-off+user+group+-+detailed
ftr+by+sign-off+user+groupt+-+detailed.atr

ftr+by+sign-off+user+group.atr
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Chapter 2
Installing on Real Application Cluster

This chapter includes the following:

S (1 (=10 17T 9
= Installing Agile PLM Business Intelligence Patch 3.2.0.2 on Real Application CIUSEer...........cccovvveriereircrninn. 9
5 POSEINSIAIAHON SIEPS ..o 10

This section lists the prerequisites, installation procedure, and post-installation guidelines for
installing Agile PLM Business Intelligence Patch 3.2.0.2 on Real Application Cluster.

Prerequisites

1. Install Oracle 11gR2 clusterware. For more information, see Oracle 11gR2 documentation.

2. Install RAC on Agile PLM Data Mart Release 3.2.0.2. For more information, see Agile PLM
Data Mart Readme Release 3.2.0.2.

Installing Agile PLM Business Intelligence Patch
3.2.0.2 on Real Application Cluster

1. Create TNS entries for Agile PLM source on each node in the cluster.

Note ETL will fail if the TNS entries are not created.

2. Install Agile PLM Business Intelligence in any of the nodes in the cluster environment by
following the installation procedure provided in the Agile PLM Business Intelligence Installation
and Setup Guide.

v.3.2.0.2 9



Agile PLM Bl Readme

Post Installation Steps

After you install Agile PLM Business Intelligence on RAC, perform the following steps:
1. Launch the ODI Operator.

Note  Agile PLM Business Intelligence can be installed on any of the nodes in the cluster.

2. Replace the URL in the Work Repository Connection window with the corresponding details of
the two nodes. The URL is displayed in the following format:

Jdbc:oracle:thin:@<host>:port:sid

To replace the URL, see the example below:
Jdbc:oracle:thin:@(DESCRIPTION=(LOAD_BALANCE-=on)
(ADDRESS=(PROTOCOL=TCP) (HOST=<NODE # 1 HOSTNAME> (PORT=1521))

(ADDRESS=(PROTOCOL=TCP)(HOST=<NODE # 2 HOSTNAME> (PORT=1521))
(CONNECT_DATA=(SERVICE_NAME=<SID NAME>)))

Note  For more information on setting up ODI Users, refer to the "Setting up ODI Users
section in the Agile PLM Data Mart Setup Guide.

3. Launch the Topology Manager and update the target JDBC database configuration for MDS.
Please refer to the example provided in Step 2.

Note  For more information, see ODI documentation or contact Oracle Support.
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Chapter 3
Known Issue

Issue

Dimensions that are premapped out-of-the-box to an Agile PLM attribute do not show any data (if
the Agile PLM attribute’s list is re-configured to a dynamic list of object data type from the out-of-
the-box standard configured list in Agile PLM Administrator). This is because; in the Bl model
(PLMA.rpd) the dimension table does a join to lookup localized data from the LANG table. As Agile
PLM does not maintain any localized data for a Dynamic object based list, it does not load into the
LANG table.

As a result, some of the reports (for example, reports using the Part Category dimension) do not
show results. In order to address this issue, follow the steps below to disable the LANG table
lookup for these dimensions in the Oracle Bl Model (PLMA.rpd).

Workaround

If you disable the language data lookup in the Bl Model, the Dimension shows actual data.

To disable the LANG table lookup for the dimensions impacted by this issue, use the steps
listed below:

1. Log in to the OBIEE Administration tool.
2. ldentify the dimension that is configured to a dynamic list.

3. Gotothe BMM layer in the rpd file and open the logical table source of the dimension.
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Chapter 4
Related Documentation

The following documents in the Agile documentation
http://www.oracle.com/technology/documentation/agile.html page on the Oracle Technology
Network http://www.oracle.com/technology/index.html., provide detailed information on the Agile
PLM Business Intelligence application:

o Agile PLM BI Setup Guide

o Agile PLM Bl User Guide

o Agile PLM BI Data Reference Manual

= Agile PLM BI Capacity Planning Guide

= Agile PLM BI MDS Configurator and Data Mapping Guide

We suggest you refer to the documentation of the following products from the Oracle Technology
Network http://www.oracle.com/technology/index.html. as they closely associate to the Agile PLM
Business Intelligence application:

o Qracle Data Integrator

= Agile Product Lifecycle Management
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